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Understanding the Business One Database Structure
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Business One Database Structure VISI(]|'|33+

TOTAL CARE

m Distinguish between related tables and a field with multiple values:

Business Partner Master Data
Code Customer *
Name Customer ‘
Forzign Name Vendor
Group Canstruction Lzzd
Currency US Dollar -

Federal Tax 1D

OCRD.CardType

Code Customer *
Mames
Farsign Name
GEroup Caonstruction b
Currency ‘Construction
Federsl Tax 1D Customars
Cistributors

S h SRl Eovernment
Tell High Tzch
-:':1;]]: S Large Accounts
o iR OCRG.GroupName
E-Matl

Smazll Accounts

s i T Define Newr Link (join) tables OCRD to OCRG
where OCRD.GroupCode = OCRG.GroupCode
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The Complete Database Reference V|S|0n33
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Use the Database Tables ) HML ko . s

Reference help file of the A

Business One Software Conirts | search | w _
. Databaze Tzbles Reference S
Development Kit (SDK) T

Q Administration

(NS

EJ @ Banking A/R Invoice
Filename: REFDB.chm L <
:
=

Table name: OINV

m

. Human Resources

@ Inventors and Production Field Description Type Size |Related Defauk

B Value Constraints

-8 m Marketing Documents and Receipt

Organized by Business One
module gi 11: ::: : :: :: :: e ] DocEntry Internal Number Int 11

I Q A/P Credit Memo DocNum Cocument Number ||Int 11

Complete table reference with f,’*," Jom et

data types, size, defaults and 5@ o o e :
. A/R CTedit Memo

ConStraIntS (ValueS) -4 4/ Down Paraent CANCELED |Cancelled arChar |t - N ves

=RV
. 19] A/R. Invoice — Fows N No

Also contains Primary Key B

DocType Document Type arChar |1 - 1 1 Ttem

Service

— Fow Expense

. . . . o ff) ”‘":f‘ E i = E“E“E“ Handwrtten [Manual Numbering |VarChar ||L - N [res
information for table joins RIS eoten e
[29] A/R. Invoice - Withholding Y
- [3] &/F Invoice — Installment

3 A.-.R Invoice — Deliverr P Printed Printed arChar ||L - N Copy
-|2] A/R Invoice - Items in Ps

W

- Base Docume (l Original

[2] A/R. Invoice - Fow Structu
.. [3] 4/R Invoice — Drawn Down la  [lamended
3 A/R Invoice — Tax Extensi
- [] /R Invoice — Asseablr - DocStatus  |[Document Status arChar |1 - o3 C  |Open
[9] A/R. Invoice (Drawn Dpa Ar
.. [J] Draft — SnB properties - lclased
-4 AR Invoice ~ Histors
: ‘_[ QA”F !(unthlv Invoice " e InvntSttus  |Warehouse Status |VarChar ||L - s (o] Open
=
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Crystal Reports Data Source V| SIOTI;!é;Ff

Each crystal report must have at least one Data Source
Release 2005/2007 Crystal used “OLE DB (ADO)” Data Source (*still supported in 8.8)
Crystal Reports for SAP Business One has new Data Source “SAP Business One”

SAP Business One source will connect via the license server (B1 user-id) OR database user-id
For security, B1 User-id is preferred and maybe required by your database administrator

Deta 'SAP Business One -

Enter connecticn details below:
Browse the data source for the tables you want to add. = et !

{Mote: to edit the alias for a table, select the table in the "Selected Tables'tree and click on it or
press the F2 key)

Available Data Sources: Selected Tables: SAP Business One Server: |hanab1:31)ﬂ15 |
(¥ [LIMS 115/Froy Log Files = SLD Server: [hanab1:40000 |
[# [ZINT Archived Evert Log
& [CONT Cumentt Evertt Log =, S [SAP HANA v]
& [Z30DBC {RDO) )
& LJOLE DE (ADC) el Company Database: | v|
 CA0utiook

& [Z30utlook/Exchangs

Compary User ID: |nwﬂ‘| |
i [ Public Folder ACL |
= [:IPUb"C Folder Admin il I = 7 Comparny User Password: |oooooouo. |
[# [ZJPublic Folder Replica I ]
(@ SAP Business One = Trusted Connection (optional):  []
& [CIWeb/1IS Log Files e |
[# [ Repostory abase User 1D (optional):

[# [Z]More Data Sources

1

Database Password {optional): | |

< Back Ned> | | Fnish | [ Caneel | [ Hep |
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Make New Connections V|S|0n33
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SAP Business One

. . Enter connection details below:
If no connections exist

Create New Connection > SAP
Business One

SAP Business One Server: |hanab1:3m15 |

Click on SAP Business One iaEn [Faneb 40000 |
Enter connection details for Server Type: [SAP HANA v
connecting to you Business One ey B [GE0DEMOUS Wi i
database (If SQL...) e
| SQL Server Name [:OI'aner)’ User D |I‘|Wﬂ1 Browse the data source for the tables you want to add.
. {Mote:to edit the alias for a table, select the table in the "Selected Tables'tree and click on it or
| LICGI"ISG Server Name and POI"t Company User Password: Ty ;r:::;:lz Eitk:;}numeg
= Database Version . r [ Add Conmard =
Trusted Connection (optional): ] 5 i
(MSSQL2005/2008) i -

Database User |0 joptional): | @ (B 01 Administration

m Company Database Name & [ 02 financias
@ [E] Budget Setup
m Business One User ID & Password Database Passward (optional): | 'ﬁﬁ

1B Cost Accounting

Financial Report Templates
Intemal Reconciliations
Joumal Entry

Once the connection is made you
Posting Templates

will see your company database < Back Next > [ ¢
name |i, ?::umng Postings

[# [ 03 Sales Opporturities

Expand that and “B1 Tables” to start E:ﬁ‘;ﬁii:a;";’;‘_w
H [# [ 06 Business Partners B
selecting your tables for your report & )07 Barkng
EIDE\n\rerrlory
[# [ 09 Production

[ [E 10 MRP
1 I3 11 Service Y
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Selecting Objects from a Data Source VlSI[]I'|33+
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m Once Connection is defined or selected, you can select tables/views from the data source

(= =T
“l.' Database Expert M

Data | Links

Browse the data source for the tables you want to add.
{MNote: to edit the alias for 2 table, select the table in the "Selected Tables tree and click on it or

press the F2 key)
Available Data Sources: Selected Tables:
EE| Add Command) - £ - & PALND04B1626A
=l [ SEQDemols JDT1

01 Administration
=1 [EE]l 02 Financials

Budget Setup
= Chart of Accounts

QACT
Cost Accounting
Financial Report Templates
Intemal Reconciliations
= Joumal Ertry

QJoT

JDTH

OTRC

QBTD

OBTF

BTF1

OCFH

CFH1

QCFW

QCFL

QCFT
7 15 Postinn Temnlates

ol [E] B1 Tables E QACT

m

oK) o ) ]
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Database Table & Field Display Options

Add to Report

Add Command to Report
Malke Mew Connection
Remove from Report

Properties

Rename Connection

Delete Connection

Remove from reposito

Rename repository,

Options

Refresh F5

rOpﬁDns Eﬁ

Database

* Right click on Database Expert to
access this pop-up menu

Show Description

2 [ZIMy Connectians.
= B8 PALNOD4S16284 1
41 Add Caenmand
E ﬂ SBODemol /S
= EEJ B1 Tables
# [E] 01 Administration
: 02 Fnancials
& ] Budpat Setup
= g3l Chaet of Accounts
511G/ Accourts
1] Cogl Accountng

H
g

Fields
¢ [ Sort Tables Alphabeticaly

") Show Description
) Show Both [T sort Eields Alphabetically

Data Explorer

| Tables Table name LIKE:

E e
D System Tables

D Synonyms Owner LIKE:

Stored Procedures (%,

Advanced Options

Use Indexes or Server for Speed

E| Perform Grouping On Server

Database Server is Case-Insensitive
Select Distinct Data for Browsing

[ Perform Query Asynchronously

Verify On First Refresh

[] verify Stored Procedures On First Refresh
Werify When Database Driver Upgraded

[¥] Automatic Smart Linking
[oc J[ cand |[ teb |
Show Name Show Both
= [ My Connections ‘onnections
@ B PALNOD4S1622A JALNDO4B162ES
= 3 PALNDO4BTEZRA 1 IALNODRIE28A_1
& [ SEODemallS & 580DemoUIS
= [ B1 Tables = [ B1 Tables

& [GH) 01 Adminigtratian
02 Fnancials = 02 Fnancials

& 0 Adminisiration

=] Chart of Accounts

Cost Accounting
Fnancial Rapon Templatas
Intsmal Reconcikations
Joumal Entry

EEEE
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Linking Report Tables VlSlOﬁééﬁ

Selected Tables:

= & PALNDO431628A
OACT [G/L Accourts]
JOT1 [Joumal Ertry - Rows]

JoT1 0ACT

B Transld - B AcctCode

B Line ID |j| / AcctMame

B Account |=| CurrTotal
Debit Foe EndTotal
Credit Finanse
SY5Cred Groups
S¥5Deb Budget
FCDebit Frozen
FCCredit Free 2

B FCCurrency Postable

B+ Duelate Fixed
SourcelD Levels

B Sourceline ExportCode

B Shorthlame Grpline

B IntrnMatch B FatherNum
ExtriMatch AcentntCod
ContraAct CashBox
LineMemao e GroupMask

| ¥

m

If your report contains data from two or more database tables,
these tables will be “linked”.

Linking requires that you use a field that is common or “alike”
to both tables.

You define the linking setup in the Links tab of the Database
Expert.

The new SAP Business One data Source is “aware” of default
joins between tables and will link the tables based on
knowledge of key structure

Review the default links set up. It is a good opportunity to
become familiar with how Business One tables are linked
(joined).

You can also override or re-order the default links based on
your report requirements.

If you use any other Data Source, (ex. OLE DB (ADQO)) please
review all links carefully

¥ =
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Linking Report Tables ViSi0n33+
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m Use Query Generator to help with these table linkages...
Bold fields in table field list are key (linked) fields in other tables.

Drag these bold fields to the table list column on the left, and the linked table will appear and the JOIN will be created
between the correct fields

Query Generator

Mams Drescription
JoT1 - TransId Transaction Key -
OACT Line_ID Row Mumber
Account Account Code From
Dbt Debit Amcunt JODTITD INNER JOIN OACT T1 ON
Credit ot Ak TO.Account = Ti.AcctCode
SYSCred Siystern Credit Amount
| Database Expert g
SYSDeb Syster Debit Amount - "‘
FCDebi Debit [Data | Lnks
Amount (FC) Whers Link together the tables you added to the report.
FCCradi Credit Amount '[FC} Linking is needed to mateh records of one table wih comespending reconds of another table
FCCurrancy Fareign Currency
[ Asto-Amange
DueDaie Due Date - omt — ——
Shorthama BPfAccount Code Sort by f :I"::S;; E B AcctCode 5 © by Hame
IntrnMatch Internal Reconcifiation No, ® hccount L‘ v S H i
ExtrMatch External Reconciiation Ne. = EncTotal
Contrafict Offset Account S¥SCed e Orer ks
: 3 Group By SVSDeb P
LineMema Row Details Feeni ik
© Rlne  AddonslReence ST s
TransT: Original Journal B DueDate Postable Lirk Opions. ]
(X[ == = ;
== Reflate Posting Date st B Sourcel Levels
B Shorthami ExportCod
— B IntmMatch GrpLine
L Eveiiie ] | Close g ExtrMatch -;atherNum
iz ContraAct centitGod
CashBox
Lineheme GroupMask v
“VL
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Table Linkage — Examples 1 VlSlﬂTﬂéé+

m OCRD (Business Partner Master)
OCRG (Card Groups)
OSLP (SalesPersons)
OUSR (Users)
CRD1 (Address)
OCPR (Contacts)
OPLN (Price Lists)

m OITM (Item Master)
OITB (Iltem Groups)
OMRC (Manufacture)
ITM1 (Item Prices)
OACT (GL Accounts)

V=
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Table Linkages - Examples 2 ViSiOTﬂéé+

mORDR (Sales Order Header)

OCRD (Business Partners) using -
RDR1 (Order Rows) using —
RDR3 (Order Freight) using
OCTG (Payment Terms) using —
OFPR (Financial Period) using -
mOINV (AR Invoice Header)
OCRD (Business Partners) using -
INV1 (Invoice Rows) using -
OJDT (Journal Entry) using -
OCTG (Payment Terms) using -
OFPR (Financial Period) using -
OPKL (Pick List) using
mJDT1 (Journal Entry Detail)
OACT (CL Account) using -

Vision33 o



Table Join Types - *Advanced Topic ViSi0n33+
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[ — (DEFAULT) An inner join requires each record in the two joined tables to have a matching record. An inner join
essentially combines the records from two tables (A and B) based on one or more fields.

n - The result of a left outer join (or simply left join) for tables A and B always contains all records of the "left"
table (A), even if the join-condition does not find any matching record in the "right" table (B).

[ -A right outer join (or right join) closely resembles a left outer join, except with the tables reversed. Every
record from the "right" table (B) will appear in the joined table at least once. If no matching row from the "left" table (A) exists,
NULL will appear in columns from A for those records that have no match in A.

|

- A full outer join combines the results of both left and right outer joins. The joined table will contain all records
from both tables, and fill in NULLs for missing matches on either side.
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Changing a Data Source on a Report

-
Y Set Datasource Location

Set Datasource Location
Can be required when running reports
from report designer. B1 will use the
current company database.

Current Data Source

This list displays the database and
tables currently used in the report. The
main report is shown as the root node.

Replace with

This list displays the same options as
the Data tab of the Database Expert.
See Data tab (Database Expert) for
information about how to select a new
data source or table.

Update Click the Update button to
update the new data source information
in the Current Data Source list. If the
new data source is different from the
one you're replacing, the Map Fields
dialog box appears.

Vision33,
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Change the location of the data source by selecting the cument database (or table) and choosing the database (or table) to

replace it with. Then click Update

Curmrent Data Source:

=] report
= f PALNDO4S 16284
= Properties
Databass Type: SAF Business One
SAP Business One Server: PALNO0481628A
License Server: PALNCGD431628A:30000
Server Type: MSSQL2008
Company Database: SEODemo IS
Company User ID: manager
Trusted Connection {optional): False
Databaze User D {optional):
= @071
H Properties
= EoACT

Replace with:

@ [ Public Folder Replica
=1 [ZA5AP Business One
*3 Make New Connection
[ i PALND0431628A
) ) PALND0431628A
#2) Add Command

(50 =] GL Detennation Test
# [E B1 Tables

[ [F bwuser
i [Eldbe
& ) INFORMATION_SCHEMA
& [Elsys
f [Z]Web/1IS Log Fies
& [ Repository
 [ZMore Data Sources

(1]

Diatabase Expert...
Set Datasource Location ..

Log On or OFF Server. ..

| Browese Data.,

Seb OLAR Cube Locstion...
Yerify Database
Show SCL Query,.,

Perform Grouping On Serwver

Select Distinct Records
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POP QU IZ Multiple Choice and True or False ViSiOTlc:!éé+

What tool(s) do ALL SAP Business One users have at their disposal to view database field and table information
Microsoft SQL Server Management Studio \/
View > System Information \/
The SDK Help files \/
SAP Community Network (SDN \/
Query Generator \/

There is a new SAP Data Source in the Current release of Crystal Reports for SAP Business One. Its name is
OLE DB (ADO)
ODBC (RDO)
ADO NET (XML)
SAP Business One \/
VSAM (LMNOP)

To use the new SAP Data Source in Crystal Report, each user must know the ‘sa’ database password

V ZF
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POP QU IZ Continued - Multiple Choice and True or False ViSi0n33+
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If you don’t know the ‘sa’ password and you're using the new SAP Data Source in Crystal Report, does the SAP Business One License Manager have to be running?

True J

False

If you import a Crystal Report or Layout from your Partners Test SQL 2005 database to your Production SQL 2008 database you will have to change your report “data
source”

True \/

False

What Menu Option do you select in Crystal to see the Table Descriptions as well as the Table Names when viewing tables for your report
File > Report Options
File > Options \/
View > Field Explorer

Right Click > Show Field Type

If you select more than one SAP Business One table for your report or layout, you must link these tables via a LEFT OUTER JOIN

True

False

V ZF
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POP QU IZ Continued - Multiple Choice and True or False ViSi0n33+
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If you want to print the Salespersons Name on your report along with customer or vendor data what two tables do you need to join in your report.
OCRD and OSLP J

CRD1 and OCRD
ORDR and RDR1
OCRD and OCPR

The default table JOIN between two tables selected for a report in Crystal is a?
LEFT OUTER JOIN
RIGHT OUTER JOIN
FULL OUTER JOIN
FULLY MONTY
INNER JOIN \/

You have to buy the Software Development Kit from your Partner to get access to the SAP Database Tables Reference help file?
True

False

What table contains a list of all SAP Business One table names used by Query Generator?
OTBL
OMG
ATBL

IDK\/ V==
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END Session #1 - Introduction VISI()|*|33+
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Crystal Reports for SAP Business One
Version 8.8 family, 9.0 family, and beyond

Carl Britton Lewis — Chief SAP Business One Ambassador



